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1. Systemvoraussetzungen

Bitte beachten Sie immer unsere aktuellen Systemvoraussetzungen im Internet, diese werden

regelmaRig aktualisiert. http://www.cgtech.de/vericut support/system-requirements/

Hinweis:

VERICUT 7.4 setzt die Installation eines aktuellen Grafikkartentreibers vorraus.
Wenn kein aktueller Grafikkartentreiber installiert ist kann es beim Starten von VERICUT 7.4
zu Problemen kommen.

CGTech www.cgtech.de support.de@cgtech.com Seite 4
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2. Installationsvoraussetzungen

Fir einen reibungslosen Installationsverlauf missen folgende Vorgaben erfiillt sein:

e  Windows-Anmeldung mit lokalen Administratorrechten

e Die Benutzerkontensteuerung (UAC) muss temporar deaktiviert werden.
2.1 Deaktivieren der Windows-Benutzerkontensteuerung (UAC)

Dies gilt nur fir Windows-Versionen seit Windows Vista, Windows XP enthalt diese Funktion noch
nicht. Nach dem Installationsvorgang kann die Benutzerkontensteuerung wieder aktiviert werden.

Vorgehensweise:

e  Windows-Startmenii
e ,uac”in Suchfeld eingeben
e Schiebregler ganz nach unten ziehen

e Mit [OK] bestatigen

gen Kir ; s N = Gl

Benachrichtigungen aber Anderungen an dem Computer auswihlen
Systemstederung (1)

wening kannverindert werden, dase durch potenziel gefihiche Pragrasnme
2 an Thrern Camputer vargenammen werden.
fi nen zu den Einsteliungen {ur dis Senutzerkoniengeysung

Q‘ Einstetiungen der Benutzeikontenstenesung Anderm

2)

Immer benschinchtigen

®  Programme versichen, Softwiee oo mstallieren oder
Anderungen am Computervomnshmen.

W
-

Ich dmdere Wirdows-Einstellungen,

W Mchit empfohlen, Wahlen Sie diess Option rur dann
aus, wenn Sie Programemne venue nden missen die fils
‘Windows 7 nicht zenifizien sind, da die

g damit

wird.

Nie berschrchligen

17 Weitere Ergebnisse snzeigen -

Qac 1 D Ruhezstend | b | |L_f¥0oKk | | Abbrechen

CGTech www.cgtech.de support.de@cgtech.com Seite 5
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3. Installation von VERICUT

Das Installationsprogramm enthélt auRer VERICUT auch den Reviewer, wahrend des

Installationsvorgangs kann gewdhlt werden welche Programme installiert werden sollen.
Seit der VERICUT Version 7.4 hat der Lizenzserver eine eigene Installationsroutine.

Hinweis:

Bitte beachten Sie, dass die Installationsvoraussetzungen aus Punkt 2 erfiillt sind.

Das VERICUT Installationsarchiv kann unter den folgenden Adressen heruntergeladen werden:

Aktuelle Version:

www.cgtech.com/products/latest-release/VERICUT-download

Vorherige Versionen:

www.cgtech.com/products/latest-release/VERICUT-download/previous-VERICUT-release

Zum Download werden eine Kunden-ID, der passende Access-Code und ein Passwort fiir das Zip-
Archiv benétigt. Diese Daten erhalten alle Kunden bei einem Release automatisch per Email. Falls

diese Daten nicht mehr vorliegen konnen sie tGiber den CGTech Support erneut zugesandt werden.

Hinweis:

Mehrere VERICUT-Versionen kénnen problemlos parallel betrieben werden.

CGTech www.cgtech.de support.de@cgtech.com Seite 6
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3.1 Start der Installation

Nach dem Download kann das Archiv extrahiert werden, die Installation startet durch die Datei
»install.exe”

1= UL U R
| "dinstall.exe |
linstallina catech oroducts.odf

Die Installation wird vorbereitet und das
Installationsprogramm startet.

Sprache wihlen

Einfihrung
1  Der Installationsassistent begleitet Sie : Einfiihrung
[ 2 2
durch das Setup ;ls:?llﬂnwm e funn Sl durch die Instaliation von CGTEch VERICUT

Es wird dringend empfahlen, dass Sie alle Programme beenden,
bevar Sie diz Installzfian fortsetzen

Klicken Sie uf Weiter', um zum nachstzn Bild schirm zu wechseln.
Wann Sis eina Einstell auf sinem vorheri irm dndem
michtan, kiicken Sie aul'Zurdek’.

Sl kannen ale Installation Jedeet abbrechen, Indzm Sie aut
‘Abhrachen’ klicken

Lizenzvereinbarung
2  Lizenzvereinbarungen Lesen und Lizenzvereinbarung
Akzeptieren un e von CGTech VERICUT 7.9

Sle den Lz
CG6Tech SOFTWARE LICENSE AGREEMENT - BY CLICHING THE *
ACCEPTANCE BUTTON OR INSTALLING OR USING THIS !
SOFTRARE, THE INDIVIDUAL OR ENTITY LICENSING THE
SOFTRARE (BEREAFTER *YOU™ OR "LICENSEE") 1§
AGREEING TC SE BOUND BY ANWD IS BECOMING X PARTY TQ
THIS AGREEMENT. IF ¥OU DO NOUT AGHEE IO ALL OF IHE
TEBMS OF THIS AGREEMENT, CLICK THE *DO NCT ACCEPT"
BUTTON AXD DO NCT INSTALL OR USE THE SOFTWARE.

DEFPINITIONS -

“Software” meana CeTecn's proprietary VERICUT(r)
COMTITAT =nfEEATE NTOOTAT. A% TAu atherwse be
(@) ioh b mut dea

(7 e tin et der

CGTech www.cgtech.de support.de@cgtech.com Seite 7




Installationsordner-auswahlen

VERICUT Installationsanleitung

3 Installationsordner wahlen.

Wenn nicht anders gewtinscht kann der
vorgegebene Pfad beibehalten werden.

Art der Installation

Installationsordner auswahlen

Bitten den instaliationsoraner auswanien!

|c:xeTecnbERIONT 74

| Standardordner wiederherstelien | | Wahlen .

sicntsor instlueyn

[E

]
=
-]
-
[}
=
-+
o
Q.

4  Installationsmodus wahlen
Fiir ein Standart-Setup wird Vollstindig
empfohlen.

Der Lizenzserver hat seit der VERICUT

Version 7.4 eine eigene
Installationsroutine.

Lizenz Server Name

Installationsart wahlen

& s Volistandig

N ‘ VERICUT Produkte, Lizenz Server, Hilfe, Beizpiek und
Tralningdateien waden ieta st Biese Option it die meister
Arae nder =mplo hlen

Partial
VERICUT Produbte, Lizenz Sewer und Hilfe datelon varden
irstallizt. Beizpiet und Trainingsdaieian werden niohtinsiallied.

Benutzercenniert
ﬁ Wanlen Sie dless Optien, um dis 2u I natallisranden Fundionsn
AnzupazEn

VERICUT [ v

5 Vorhandenen Lizenzserver wéhlen oder
einen Neuen installieren.

Vorhandenen Lizenzserver aus dem Netzwerk verwenden:

IP-Adresse oder Klarnamenpfad des Lizenzservers

Vorhandenen Lizenzserver auf diesem Computer
verwenden:
,localhost” fur lokal installierte Lizenzen.

Lizenzserver auf diesem Computer installieren:
Fiihrt die Lizenzserver-Installation nach der VERICUt-
Installation aus.

Lizenzserver Hostname

| eineh Newen

Lizenzserver 1st auf diesem Compiter nicht
nstalfiert.
desLi s b

Ll

» Vorhiandenen Lizenzs erver aur diesem Comgpuler verwen...

eIVEr WUrde AUt diesem Compuier

goppooooaan

WERCUT
TecH” @

VERICUT ||

Verknipfungen

6  Einstellen an welchen Orten
Verkniipfungen zu VERICUT erstellt
werden dirfen.

CGTech www.cgtech.de

VERICUT Verknupfungen

Wo mochten Sie VERICUT Yerknupfungen
erstellen?

dem Desktap

1 In der Schnelstartisiste

1In einer Programmoruppe
CGTedh YERIQUT 7.2

Seite 8
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Verknipfungen
7 Hier kann gewahlt werden welche
Verknipfungen angelegt werden sollen.

Der VERICUT-REVIEWER ist Lizenzfrei
installierbar!

Standardeinheiten

VERICUT Produkt Shortcut

lwamen Sie das VERICUT Produkt Ehortout far gie Installztion in
| Pragrammgruppe (CGTech VERICUT 7 4) Fur derzeltigen Anwendear

] 1) VERICUT
2) VERICUT Single Piatform
3) Reviewer
'] 4) VERICLTT Driing and Fastering (VDAF)

8 Mit welcher Standard-Einheit soll VERICUT
gestartet werden?

Schnittstellen

VERICUT Standardeinheiten

|VERICUT stanaargeinneitan wanhlan

| Diese Enstellung kann In YERICUT geanaert werden

9  Falls STEP-, ACIS- oder CATIA-Dateien
bearbeitet werden sollen, kann das CAD
Models Interface direkt installiert werden.

Falls eine der unterstlitzten CAM-

Schnittstellen verwendet werden soll,
kann diese hier gewahlt werden

Ubersicht vor Installation

VERICUT Schnittstellen

EspalInterface

[ Edgacam Interface

12015Rz [ 12015R1 | |2014R25U2 | 2014R1

or Installie s

WERCUT
TecH” @

VERICUT T

12013R2 [ 12013R1

" Mastercam Inlerface

Jxe Clxe Cixr CIx6

10 Die Installationsiibersicht fasst alle
getroffenen Einstellungen zusammen.

Bitte Kontrollieren.

CGTech www.cgtech.de

Ubersicht vor Installation

l“leﬂ““fﬂl Sle bitte tlas Folgende, bevor Sie fortfahren;

Produktname:
CGTech VERICUT 74

Installationsordner:
CCGTech VERICUT_74 =

Produktkomponenten:
VERICUT
Hilfe Dateien
Bespiel & Trammgs Datejen

Installierte Verkniipfungen (Fiir derzeitigen
Anwender)
Programmgrugpe (CGTech VERICUT 74)

VERICUT m=wm merew

support.de@cgtech.com Seite 9




Installiert ...

VERICUT Installationsanleitung

11 Der Installationsvorgang startet, VERICUT
wird installiert.

Fertig

CGTech VERICUT 7.4 wird installiert

Machine Simulation

VERICUT Machine
Simulation helps prevent
crashes, improves process
efficiency, and protects
your investment!

VERICUT

For mars ietermatisn wise Cglech.com

12 Auswahl selektieren um weitere
Informationen angezeigt zu bekommen
oder um die Lizenzserver-Software zu
installieren.

Fertig

Installation volistandig

a

Abhangly von thren lokalen Gegebenheften sind nach
der vieise weltere

KorMgurationsschritte notwendiy.

]

die fur den
1 L 2ur
voh CAD oder anderen
Aufgaben anzuzelgen.

T Abschiisl

Ausvrahlen um den Lizenzserver auf diesem Computer zu

gedssaxaf|ax

13 Herzlichen Glickwunsch, die Installation
wurde erfolgreich Beendet.

Bitte Punkt 3.2 der Installationsanleitung
beachten!

CGTech www.cgtech.de

Installation abgeschlossen

Herzlichen Gluckwunsch! CGTach VERICUT 7 4 wurds erfolgrelen
Installlert in:

CUCETechWERICUT_74

Klicken Sis auf*Ferlig", um den Installer zu heendsn.

VERICUT e}

support.de@cgtech.com Seite 10
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3.2 Microsoft Runtime-Dateien

Je nach Windowsversion, Softwareinstallationen und Updatestand miissen die aktuellen Microsoft
Visual C++ Runtime-Dateien installiert werden.

CGTech liefert aktuelle Versionen dieser Dateien mit dem Installationsarchiv mit.

Diese liegen im VERICUT-Installationsverzeichnis im Unterordner redist, zusatzliche Runtime-Dateien
fur die Model-Interfaces liegen im Unterordner windows(64)\spatial\redist.
Alternativ sind alle Runtime-Dateien auch gesammelt unter folgender Adresse zu erhalten:

http://download.cgtech.com/redistributables.zip

Ordner 6ffnen und daraus je nach ihrem Systemtyp folgende Runtime-Dateien installieren:
e Windows 32Bit: Alle Dateien mit *x86* im Dateinamen.

e Windows 64Bit: Alle Dateien mit *x64* im Dateinamen.

Hinweis:

Falls statt einer Installationsroutine ein Reparaturmodus startet, kann die Installation abgebrochen
werden, da die benétigten Dateien bereits installiert sind.

CGTech www.cgtech.de support.de@cgtech.com Seite 11
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4. Installation der Lizenz

Je nach bestellter Lizenz kann der Lizenzserver auf einem Arbeitsplatzrechner oder auf einem

Netzwerkserver betrieben werden, die Installation unterscheidet sich dadurch ein wenig.

Hinweis:

Fiir VERICUT ab Version 7.3 wird mindestens die Version 8.5.3.35 der Lizenzserver-Software benétigt!
Die Version ist unter anderem (iber WImAdmin einsehbar.

4.1 Ermitteln der Host-ID

Zum Beantragen einer VERICUT-Lizenz ist die Host-ID des Lizenzservers nétig, diese kann tber das

Programm hostinfo.bat im Installationsarchiv des Lizenzservers angezeigt werden.

e Seit 7.3 abwarts finden Sie dieses Programm auch im Windows-Startmeni unter Start > Alle
Programme > CGTech VERICUT 7.X > License Server > Anzeige der HOST ID.
e Alternativ kann das Programm auch hier heruntergeladen werden:

box.maschinen-simulation.de/cgtech hostinfo.zip

i e Host ID for this computer:

License Server Hoszt Machine Information
Uersion: 8§.2.1.408

Hostname: TETRATTS-FC
Ethernet 1: DAGT7E?SYA25D

Ethernet 2: 24770727 75FC
Ethernet 3: 03882080 F31D

Hinweis:

Bitte beachten, dass VERICUT Lizenzen seit Version 7.3 nur dann auf virtuellen Servern lauffdhig sind,
wenn sie auch fiir virtuelle Server generiert wurden.
Weitere Informationen unter: http://www.cqgtech.de/vm/

CGTech www.cgtech.de support.de@cgtech.com Seite 12
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4.2 Installation der Lizenzserver-Software
Hinweis:

Bitte beachten, dass die Installationsvoraussetzungen aus Punkt 2 erfiillt sind.

Der Installer der VERICUT Lizenzserver-Software ist auch im VERICUT Installationsarchiv vorhanden

und kann Gber , license_server_install.exe“ gestartet werden.

0y, 7 installing_cgtech_products.pdf

( - -
|@ license_server_install.exe

5. LicenseTool.exe

Die Installation wird vorbereitet und das Installationsprogramm startet.

Einfihrung
1  Der Installationsassistent begleitet Sie
durch das Setup.

InstaliAnywhare will guide you through the installation 01 CGTeeh
License Server

Itis strongly recammends=d thatyou quit all programs befars
continuing with this installation

Clickthe 'Nex'button to procezd ta the nexi screen. If you want to
changs somathing on a previous screen, click the Previous' buttan.

You may cancel this installaton at any tme by clicking tha ‘Cancel’
hutton

Lizenzvereinbarung
2  Lizenzvereinbarungen Lesen und
Akzeptieren.

Instaliation and Use of CGTech License Server Requires
Acceptance of the Following License Agreement:
|C6Tech SOFTVARE LICENSE AGREEMENT - BY CLICHING THE =
!ACCEFTKNCI BUTTON 0R IN3TALLING OR USING THIS =
|SOFTWARE, THE INDIVIDUAL OR ENTITY LICENSING THE

| SoPTRARE (HEBEAFTER "YOU" OR "LICENSEE") IS

3;0@}:11!(; TO BY BOUXD BY AND 15 BECOMING A PARTY TO

| THIS AGRIXMENT. IF YOU DO NUT AGRXE T3 ALL OF THE
|TEBMS OF THIS AGREEMENT, CLICK THE “DJ NOT ACCEPT"
|BUTTCN AND DI NOT INSTALL OR USE THE 3OFTVARE,

|DEFINITIONS -
[

!"So:twaze" neang CtTech's propristary VIZRICUT(r)
conriter softxsare nroaran. as nav ntheareis= he

o

() 1 do NOT accept the tenrs of the Learse Seement

VERICUT E=amm

CGTech www.cgtech.de support.de@cgtech.com Seite 13




Installationsordner-auswahlen

VERICUT Installationsanleitung

3 Installationsordner wahlen.

Wenn nicht anders gewtinscht kann der
vorgegebene Pfad beibehalten werden.

Verknipfungen

Where Would You Like to Instali?
[C2Pregrom Firs|CGTechnerse Sever

L Restore Default Folazr n Cheose ., ]

VERICUT

4  Einstellen an welchen Orten
Verknipfungen zum VERICUT Lizenzserver
erstellt werden dirfen.

Ubersicht vor Installation

Where would you like to create the CGTech
License Server shortcuts?

¥ In 2 Program Group

CGleth Leense Server

5 Die Installationsibersicht fasst alle
getroffenen Einstellungen zusammen.

Bitte Kontrollieren.

Installiert ...

Please Review the Following Before Continuing:
r

Install Folder:
CACGTechLicenseServer

Program Group (for All Users)
CGTech License Server

Disk Space Information (for Installation
Target):

Requoed: 110450 828 Byles
Auvailable: 124 655 436480 Bytes

6  Der Installationsvorgang startet, der
VERICUT Lizenzserver wird installiert.

CGTech www.cgtech.de

CGTech Services

CGTech offers a wide range
of custom eonsulting
services:

= NC program optimization

= CNC machine tool medeling

= CAD model export

= On-site trainiag

= and much morel

VERICUT

For mart intwrmstion wisit Cglech.com

support.de@cgtech.com Seite 14
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Fertig
7 Herzlichen Gluckwunsch, die Installation
wurde erfolgreich Beendet.

| Congratulations! CGTach Licanse Sarver has been successiully
linstallsd to

CACGTeenLicense5aner

| Fress *Dane"ta quit the installer

Verlassen Sie den Dialog liber die
Schaltflache [Done].

LGTecH” E ‘

Im néchsten Schritt muss nun noch die Lizenz selbst installiert werden. Weitere Informationen dazu

unter Punkt 4.3.

4.2.1 Update der Lizenzserver-Software (z.B.: fiir VERICUT 7.4)

Hinweis:

Fiir VERICUT ab Version 7.3 wird mindestens die Version 8.5.3.35 der Lizenzserver-Software benétigt!
Die Version ist unter anderem iiber WImAdmin einsehbar.

Im ersten Schritt muss die alte Version der Lizenzserver-Software deaktiviert werden, dies
funktioniert tGber den Startmeni-Eintrag: , Entfernen des Lizenz Servers”.

Das anschlieBende Update der Lizenzserver-Software wird generell wie eine komplette
Neuinstallation ausgefiihrt. Die Installation funktioniert wie unter Punkt 4.2 beschrieben.

4.3 Installation einer Lizenz auf dem Lizenzserver

Auch nach einem Update der Lizenzserver-Software muss dem Punkt 4.3.1 gefolgt werden.

CGTech www.cgtech.de support.de@cgtech.com Seite 15
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4.3.1 Erstinstallation
Hinweis:

Bitte beachten, dass die Installationsvoraussetzungen aus Punkt 2 erfiillt sind.

Dieser Vorgang muss nur auf dem Computer, auf dem der Lizenzserver laufen soll, ausgefiihrt

werden!

Konfiguration von Lizenz und Setupserver aus
dem Windows-Startmenii unter Alle
Programme > CGTech License Server > License
Server Only > Configure License & Setup Server

ie eine beliebige Taste . . .

zweimal mit Enter bestatigen

Bei der Installation des Lizenzservers wird die
Systemvariable ,,LSERVOPTS” gesetzt.

Der Wert dieser Variablen lautet
-s"C:\ProgramData\CGTech\license\cgtech.If"

Wenn der Lizenzmanager hier eine Fehlermeldung
anzeigt muss die Systemvariable “LSERVOPTS” von
lhnen angepasst werden.

Die erhaltene Lizenz in diesem Fenster ablegen.

Folgende Vorgehensweisen sind moglich:

e Kompletten Inhalt der Lizenzmail per
Drag&Drop in dieses Fenster ziehen.

o Kompletten Inhalt der Lizenzmail per
Copy&Paste hier einfiigen.

e Speichern der Lizenzmail als Textdatei
und per Drag&Drop in dieses Fenster
Zlehen Livenatewi P05 amDas|CGTach] canssegtach ¥ adolgraich arwatt

In der letzten Zeile sollte nun zu sehen sein:
,Lizenzdatei C:\ProgramData\CGTech\license\cgtech.|f erfolgreich Lizenzdatei C\ProgramData\CG Techilicenselcgtech.If erfolgreich erstellt

erstellt”,
Fenster schlieBen und mit Enter in der
Schliessen

Kommandozeile bestatigen.
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Es wird Empfohlen ihre VERICUT-Installation jetzt zu testen!

e Falls der Lizenzserver auf dem Arbeitsplatzrechner installiert ist sollten sich VERICUT nun

direkt starten lassen.

o Falls der Lizenzserver nicht auf dem Arbeitsplatzrechner installiert ist, missen die VERICUT-

Arbeitsplatze eventuell noch wie in Punkt 4.4.2 beschrieben konfiguriert werden.

Der Lizenzserver nun richtig Konfiguriert.

Hinweis:

Falls Fehlermeldungen auftreten, bitte die Installationsvoraussetzungen aus Punkt 2 und den FAQ-
Bereich unter Punkt 7 beachten.

CGTech www.cgtech.de support.de@cgtech.com Seite 17




4.3.2 Lizenz-Update

Hinweis:

VERICUT Installationsanleitung

Fiir VERICUT ab Version 7.3 wird die aktuelle Version des Lizenzservers bendétigt!
Bitte beachten, dass die Installationsvoraussetzungen aus Punkt 2 erfiillt sind.

Dieser Vorgang muss auf dem Computer, auf dem der Lizenzserver laufen soll ausgefiihrt werden.

Starten des Programms Save License File From
Email aus dem Windows-Startmenii unter Alle
Programme > CGTech License Server > License
Server Only

Die erhaltene Lizenz in diesem Fenster ablegen.

Folgende Vorgehensweisen sind moglich:

e Kompletten Inhalt der Lizenzmail per
Drag&Drop in dieses Fenster ziehen.

e Kompletten Inhalt der Lizenzmail per
Copy&Paste hier einfiigen.

e Speichern der Lizenzmail als Textdatei
und per Drag&Drop in dieses Fenster
ziehen

Im Textfeld des Fensters sollten nun einige
Lizenzinformationen zu sehen sein.

Bitte priifen ob der Code unter Ethernet der
Host ID des Lizenzservers entspricht.

In der letzten Zeile sollte nun zu sehen sein:
,Lizenzdatei
C:\ProgramData\CGTech\license\cgtech.If
erfolgreich erstellt”,

Fenster mit Close schlieRen und mit Enter in der
Kommandozeile bestatigen.

CGTech www.cgtech.de

(53 VERCUT Lesrartate eriicien

YrogramDes 05 Tochiicensercghech If

chhesson |

LSERYOFTS = -3 "C:iFrogramDansl CCTechilicenselcgiach I

HostID's dieses Computers: 247203 E64826. ENDBSEDDFECT
DragDrop der YERICUT Lizenzemail oder Textdstel oder Kopieren und Einfugen von Emsiltext unten |

() abler 1D: 030690

W Ethernet

+Sep-2016 Qty: 10

% Multi- Sep-2016 Qiy: 10

& OptiPath 2016ty 10
# AUTC-DIFF 7.4 30-Sep-2015 Oty: 10
¥ Maching Simi 7.4 .30-5ep-2015 Qty: 10

# Machina Developar's Kit 7 4 30-Sep-2016 Qty: 10

W Advanced Machine Features
# Cutter Grinder Interface 7.4 3

ep-2015 Ry 10
2015 Qty. 10

| -
d&e nzdatel C\PogremDale\CG Tech\icensel\oylech If erdolgreich ersleD

Schliessen
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Es wird Empfohlen ihre VERICUT-Installation jetzt zu testen!

Um die Lizenz dauerhaft zu aktivieren, muss das Programm Update Licenses on Running Server aus
dem Windows-Startmeni unter Alle Programme > CGTech License Server > License Server Only

ausgefiihrt werden.

Die Lizenz ist ab sofort dauerhaft aktiviert.

Der Lizenzserver nun richtig Konfiguriert.

Hinweis:

Falls Fehlermeldungen auftreten, bitte die Installationsvoraussetzungen aus Punkt 2 und den FAQ-
Bereich unter Punkt 7 beachten.
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4.4 Lizenziibertragung

4.4.1 Lizenziibertragung anfordern

Durch @ndern des Lizenzservers wird auch eine neue Lizenz benétigt, diese kann auf unserer
Homepage unter folgender Adresse beantragt werden:
www.cgtech.de/VERICUT support/request-license

4.4.2 VERICUT fiir neuen Server einstellen

Im Falle eines Lizenzserverwechsels muss VERICUT mitgeteilt werden wo es nach einer VERICUT-

Lizenz suchen soll.

Dabei hilft seit VERICUT 7.3 der folgende Startmeniieintrag: Alle Programme > CGTech VERICUT 7.4 >
Lizenz Administration > Lizenz Server Namen angeben.
Alternativ findet sich das Programm auch im VERICUT Installationsverzeichnis unter VERICUT

7.4\windows64\commands\change_cgtenv.bat

Andern der Zeile:

Datei Bearbeiten Format Ansicht ?
mecho off

set LSHOST=localhost

. X rem cGTech, Copyright, A1l Rights Reserved
von localhost auf die Adresse des Lizenzservers,

z.B.:

rem This file sets up the CGTech License environment
rem it should be called from another CGTech batch fil

rem The following environment variable specifies the ]
< 2 = ame after the "=" to specify a di

o 8| i
|set LsHOST=Tlocalhost

set LSHOST=licenseserver01 ‘

.. ,“’,w-«. REPFER L YO M_Mm e aomaipbielih.

Falls bereits eine Windows Umgebungsvariable mit der Benennung LSHOST angelegt wurde, muss
diese auch geandert werden.

Die Konfiguration ist nun abgeschlossen.
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5. Models Interface

Je nach bestellter Lizenz kénnen (iber das VERICUT Models Interface verschiedene Import- und
Export-Schnittstellen verwendet werden.

Hinweis:

Seit VERICUT 7.3 kann dies bei der Installation direkt mit angewdhlt werden.

Falls das Models Interface bei noch nicht installiert ist, wird die Datei unter folgendem Downloadlink
bendétigt:
www.cgtech.com/products/latest-release/VERICUT-download/model-interfaces

VERICUT Beenden.

e Datei herunterunterladen und entpacken.
e Programm install.exe ausfiihren und den Anweisungen folgen.

e Bei,Installationsordner auswahlen“ muss der Pfad zur aktuellen VERICUT-Installation
angeben.

(Beispielpfad.: C:\Programme\CGTech\Vericut 7.4)

e Im Ordner Redistributables werden aktuelle C++Runtime-Dateien mitgeliefert. Falls diese
nicht bereits bei einer vorherigen Installation installiert wurden, sollte dies nun nachgeholt
werden.

Siehe dazu Punkt 3.2.

o Fir gewdhnlich muss folgende Datei installiert werden:

InstallDSSoftwareVC9Prerequisites_x86_64.msi aus dem Ordner:

Installationsverzeichnis\windows(64)\spatial\redist

Die Installation der Model Interfaces ist nun abgeschlossen.
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6. Installation der *CAM-to-VERICUT-Schnittstellen

Um den CAM-Export moglichst einfach zu machen, liefert CGTech mit VERICUT bereits einige
Schnittstellen zu CAM-Software mit.
Diese Schnittstellen missen nach der VERICUT-Installation noch in ihrem jeweiligen CAM-Programm

aktiviert werden.

6.1.1 CATIAV5-to-VERICUT

Die CATIAV5-Schnittstelle (CATV 7.4 Build 1) setzt mindestens eine CATIA V5 (R16 oder hdher)

Installation voraus.

e CATIA und VERICUT beenden

o Kopieren der Dateien I_CATV.bmp aus dem VERICUT Installationsverzeichnis
(Beispielpfad: C:\Programme\CGTech\Vericut 7.4\windows64\catv5)
aus den Unterordnern: Normal und Small
in das CATIA Installationsverzeichnis unter intel_a\resources\graphic\icons

(Beispielpfad: C:\Programme\Dassault Systemes\B16\intel_a\resources\graphic\icons)
In die Ordner Normal und Small

e CATIA VS starten
e Inden ,Advanced Machining“-Bereich wechseln
¢ |Im Meni: Tools > Makro > Makros wahlen
o Auf Makrobibliotheken klicken
= Vorhandene Bibliothek hinzufiigen...
e Wihlen des Eintrags im Unterordner windows(64)\catv5 des
VERICUT-Installationsverzeichnisses.
(Beispielpfad: C:\Programme\CGTech\Vericut 7.4\windows64\catv5)
= Fenster Makrobibliotheken schlieBen
o Fenster Makros schlief3en.
e Im Menli: Tools > Anpassen wahlen
o Auf den Reiter Befehle wechseln

= Links die Kategorie Makros wahlen
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= Rechts unter Befehle: CATV.CATScript wahlen

= Darunter auf Eigenschaften anzeigen... klicken

= Durch Klick auf den Button ,,...“ 6ffnet sich der Icon-Browser, hier muss das
VERICUT-Symbol gesucht und gewahlt werden.

= Die Benennung des Icons auf ,VERICUT” dndern

= Den Eintrag CATV.CATScript mit der Maus per Drag&Drop an die gewiinschte
Stelle in der CATIA-Toolbar ziehen

Das Fenster Anpassen schlieen

Die Installation der Schnittstelle ist nun abgeschlossen.

CGTech
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6.1.2 CATIAV6-to-VERICUT

1. Testen Sie zunéchst, ob Sie die CATV6-Schnittstelle manuell starten kdnnen.
Wechseln Sie dazu in Ihrem VERICUT-Installationsverzeichnis (z.B. C:\CGTech\VERICUT_7.4.1)

in den Ordner ,,..windows64\CATV6“ und starten die Datei ,catvb.exe” mit einem

Doppelklick.

@uv‘ ; » Computer » OS(C] » CGTechlb WERICUT 741 » windowsBd » CATVG

Organisieren * Offnen Brennen Meuer Ordner

43 Eavoriten b Anderungsdatum Typ

B Desktop [ catvf.exe 24.09.2014 22:41 Anwendur
| O S
{3 VERICUT Interface =&
Project Settings v [y
Output Directory

The interface to VERICUT needs DELMIA V& or CATIA VB running. Do you want to
Name start either of them now?

Project Template

[7] Append to existing setups in

Setup Template | Models | Tooling I NC Programs. | Subroutines | Coordinate Systems i Machine SEﬂ.ingsl

2. Kopieren Sie aus Ihrem VERICUT-Installationsverzeichnis die Icons (*.bmp)
“Normal” (z.B. C:\CGTech\VERICUT_7.4.1\windows64\catv5\Normal) und

“Small” (z.B. C:\CGTech\VERICUT_7.4.1\windows64\catv5\Small)
in folgende Ordner lhrer CATIA V6 Installation:
C:\Program Files\Dassault Systemes\B214\win_b64\resources\graphic\icons\normal

C:\Program Files\Dassault Systemes\B214\win_b64\resources\graphic\icons\small

3. Starten Sie CATIA V6 und wéhlen Sie aus dem Men( den Eintrag = Tools 2 Macros 2>
Macros (oder driicken Sie auf der Tastatur ALT & F8) und wahlen Sie im sich 6ffnenden
Fenster den Eintrag = Macro Libraries aus.

Current macro library or document:

Available macros:

MName Language
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4. Whibhlen Sie im folgenden Fenster bei = Library type den Typen = PLM Directories aus und
kllcken anschlieBend auf - Create New Library

||| Loy type: ‘
| (23 PLM Directories -
Current libraries:

Add existing library... |

Ay

Create new library from files ]

mit > OK.

_.% Macro library VB Script

Mame VERICUT_CATVE Script i

Description [

[’ QK ]( Cancel ]

6. Verlassen Sie das Fenster = Macro libraries tiber = Close.

Library type:
[Z1 PLM Directories
Current libraries:

VERICUT Script. —— Add existing library...

Remove selected library

Create new library from files ... ]

7. Im Fenster = Macros wihlen Sie bei = Current Macro das gerade erstellte
VERICUT-Script aus und klicken dann auf = Create.
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Current macro library or document: ‘

[:]VERICUT_ScrEpt --- = | Macro libraries...

Soailoble ma o erac

Mame Language

Obfuscate..,

8. Waibhlen Sie nun bei = Macro language - CATScript aus und geben Sie als 2 Macro name 2>
CATV6.CATScript an. Verlassen Sie die Maske Gber 2 OK.

To create a new macro in the current macro library or document,

choose the macro language and the macro name.

Macro language:
CATScript - |

Macro name:
CATVE.CATScript]

r Ok ]f Cancel }

9. Waihlen Sie nun = Edit.

Current macro library or document:
(1 VERICUT Script ---
Available macros:

Marne Language

CATVE.CATScript CATScript Edit...

|
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10. Fugen Sie folgende Zeile zwsischen = Sub CATMain() und = End Sub ein:
CATIA.SystemService.ExecuteBackgroundProcessus

"C:\cgtech74x\windows64\commands\catv6.bat"

=>» Der Pfad zu Ihrer VERICUT-Installation muss ggf. angepasst werden!

Sl O ATHRA

CATIA SystemService ExecuteBackgroundProcessus "Chegtech?3dwindows4\ commands\.catvd.bat” |

cnd sub

Line: 4, Column:1

11. Wéhlen Sie = File > Save aus und verlassen Sie dann die Maske (iber = File > Exit.

12. Verlassen Sie das = Macros Fenster Uber = Close.
13. Wahlen Sie im CATIA Menl = Tools = Customize = Commands aus und wéahlen Sie die
Kategorie = Macros an. Dann wéhlen Sie das = CATV6.CATScript aus und klicken auf 2>

Show Properties.

| Start Menu I| User Werkbenches I| Toolbars | Commands | Options !

Categorie: Commands

Object Subscriptions PN [ CATVE.CATScript
Select

Tools

Type Subscriptions

View =
Window B
ECﬁ

CATVE.CATScript

I Show Properties.., ]

( VR Button Customization ]

?Use this page to add or delete commands to toolbars.
Drag and drop commands onto toolbars to add commands,
Drag and drop cemmands from teolbars onto the commands list to delete commands,
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Seite 27



VERICUT Installationsanleitung

L/
14. Klicken Sie auf > ===l und wéhlen das Symbol 2> QI VERICUT aus der Liste aus.

» Hide Properties... leorsBrovest —i
VR Button Customization Hd 4»| Page 22 of 215
?Usathis page to add or delete commands to toolbars, é / ;é __'_J _! A@l
Drag and drep commands onto toolbars to add commands.
Drag and drop commands from toolbars onto the commands list to delete commands. m}éi_L_i_J .ﬁl

Command Properties !@_J._I_]__l
Title: CATVE.CATScript Icon: ) |§| ! _J_!_}_l_]

- le® |8 5

=|
User Alias: E Eﬁ__!@ @j I
Accelerator; ‘ @ @ @ E
(Ccet )Y shift Y &k J Other.. ) . D@% 2|2 é i

15. Verlassen Sie Uber = Close den Icon-Browser.
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16. Wihlen Sie im = Customize Fenster 2 Toolbars aus.
Klicken Sie dann auf eine Toolbar Ihrer Wahl, z.B. Standart, und klicken dann

auf 2 Add commands.

| Start Menu I| User Workbenches | Toolbars | Commands I| Options I

Toolbars

[Stancard N
Workbench
Graphic Properties
Knowledge

View 3 Restore contents...
‘Workbenches

ool Palctte Restore all contents...
3Dx Device Restore position
Material Toolbar

Maintenance Tools

PLM Applicability Project Access Add commands...
Immersive Virtuality e
Catalog

Statistics

?Use this page to add or delete a toolbar to the current workbench.,
The Commands page allows drag8drop to add/remove commands.

Close

17. Wahlen Sie = CATV6.CATScript aus und klicken auf = OK.

-

Commands list m

Title Ic...  Accelerator s

CATSimObservationOptionsDisplay Cmd... |:|
CATSimObservationOptionsHideCmdHdr

CATVE.CATScript v

| | COPY Operator Instruction 2k
CATVE.CATScript |

I [ oK ][’cmsejl

18. Verlassen Sie das = Customize Fenster (iber = Close.
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6.2 Edgecam-to-VERICUT
Hinweis:

Diese Schnittstelle kann seit Version 7.3 direkt mit VERICUT installiert werden.

Das VERICUT Menii im Edgecam Menii und in der Edgecam Toolbar integrieren:

Starten Sie Edgecam

e Wechseln Sie in den Manufacture Mode
e Machen Sie in der Meniibar einen Linksklick und wahlen Customize
o Wabhlen Sie den Reiter Transfer
o Klicken Sie neben Toolbar auf den Button Load
o Wabhlen Sie die Datei VERICUT.commands
=  Wiederholen Sie dies fir Menu
e Die VERICUT-Schnittstelle wird in Edgecam ab sofort in der Toolbar und im MenU angezeigt.

Die Installation der Schnittstelle ist nun abgeschlossen.
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6.3 Mastercam-to-VERICUT
Hinweis:

Diese Schnittstelle kann seit Version 7.3 direkt mit VERICUT installiert werden.

Diese Installationsanleitung bezieht sich auf Mastercam X6, andere Versionen kénnten abweichen.
e Beenden Sie Mastercam und VERICUT.

e Kopieren Sie folgende Dateien aus ihrem VERICUT Installationsverzeichnis
(Beispielpfad: C:\Programme\CGTech\Vericut 7.4\windows64\mcamv\X6)
in ihr Mastercam Installationsverzeichnis

(Beispielpfad: C: \Programme\Mastercam).
o SetStock.dll nach chooks\SetStock.dll
o VERICUT.dIl nach chooks\VERICUT.dII
o VERICUT.ft nach chooks\VERICUT.ft
o Mcres.local nach chooks
o VERICUTSupport.dil nach chooks\VERICUTSupport.dll

e Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen:

Variable Beispielwert (Erkldarung)
CGTECH_INSTALL C:\Programme\CGTech\Vericut 7.4
CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64
LSHOST Licenseserver01

(Hostname ihres Lizenzservers)

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen.
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Die VERICUT Schnittstelle in die Mastercam Toolbar integrieren
e Starten Sie Mastercam

e Wihlen Sie im MenU: Einstellungen/Anpassen
o Wechseln Sie im Anpassen Fenster auf die Kategorie NET Hook
o Wahlen Sie das VERICUT Icon und ziehen es per Drag&Drop auf die Toolbar im

Mastercam-Fenster.

e Die VERICUT-Schnittstelle wird in Mastercam ab sofort in der Toolbar an der gewahlten Stelle

angezeigt.

Die Installation der Schnittstelle ist nun abgeschlossen.
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6.4 NX-to-VERICUT

Diese Installationsanleitung bezieht sich auf NX 7.5, andere Versionen kdnnten abweichen.
e Beenden Sie NX und VERICUT.

e Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen:

Variable Beispielwert (Erklarung)
CGTECH_INSTALL C:\Programme\CGTech\Vericut 7.4
CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64
LSHOST LicenseserverQ1

(Hostname ihres Lizenzservers)

UGS_LICENSE_BUNDLE NCFOUND;NXPTNR100

UGII_VENDOR_DIR %CGTECH_PRODUCTS%\nx\NX7.5\german (Pfad zu
ihrer NX-Schnittstelle)

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen.

e Die VERICUT-Schnittstelle wird in NX ab sofort in der Toolbar angezeigt.

Die Installation der Schnittstelle ist nun abgeschlossen.

Alternativ kdnnen Sie NX auch Uber eine Batch-Datei im VERICUT Installationsverzeichnis starten.

(Beispielpfad: C:\Programme\CGTech\Vericut 7.4\windows64\commands\nx7_5.bat)
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e Beenden Sie Gibbs und VERICUT.

e Kopieren Sie folgende Datei aus ihrem VERICUT Installationsverzeichnis

(Beispielpfad: C:\Programme\CGTech\Vericut 7.4\windows64\GibbsV)

in ihr Gibbs Installationsverzeichnis

(Beispielpfad: C: \Programme\Gibbs\GibbsCAM\8.0.19_NLO\plugins).

o GibbsV.dIl

e Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen:

Variable Beispielwert (Erklarung)
CGTECH_INSTALL C:\Programme\CGTech\Vericut 7.3
CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64
LSHOST Licenseserver0O1
(Hostname ihres Lizenzservers)
GIBBSV_LANGUAGE %CGTECH_PRODUCTS%\GibbsV\GibbsvGerman.local

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen.

e Die VERICUT-Schnittstelle wird in Gibbs ab sofort im Men Plugins angezeigt.

Die Installation der Schnittstelle ist nun abgeschlossen.
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6.6 Pro/Engineer-to-VERICUT

Diese Installationsanleitung bezieht sich auf Pro/Engineer Wildfire WF50, andere Versionen kénnten

abweichen.

e Beenden Sie Pro/E und VERICUT.

o Kopieren Sie die Datei protk.dat aus ihrem VERICUT Installationsverzeichnis
(Beispielpfad: C:\Programme\CGTech\Vericut 7.4\windows64\proev\WF50)
in ihr Pro/E Installationsverzeichnis unter \text

(Beispielpfad: C:\Program Files\proeWildfire 5.0\text).

e Andern Sie mit einem Texteditor den Dateiinhalt so ab, dass er passend zu ihrer VERICUT-

Installation folgendem ahnelt:

name cgtproev

startup dll

exec_file C:\Programme\CGTech\Vericut 7.4\windows64\proev\WF50\cgtproev.dll
text_dir C:\Programme\CGTech\Vericut 7.4\windows64\proev\Wf50\text

revision Wildfire

end

e Falls Sie an einem 64Bit Betriebssystem arbeiten, kopieren sie die Datei cgtproev.dll aus dem

Ordner x64 Uber die Datei im WF50-Ordner.

e Die Datei proev.txt enthalt die Beschreibungen, die spater im Pro/E Popdownmeni angezeigt

wird.

Die Zeilen ,, VERICUT...” und ,, Invoke the VERICUT Interface” konnen beliebig gedandert

werden.
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e Falls nicht bereits vorhanden, erstellen Sie die folgende Windows-Umgebungsvariablen:

Variable Beispielwert (Erkldarung)
CGTECH_INSTALL C:\Programme\CGTech\Vericut 7.4
CGTECH_PRODUCTS %CGTECH_INSTALL%\windows64
LSHOST Licenseserver01
(Hostname ihres Lizenzservers)
PROEV_LANGUAGE %CGTECH_PRODUCTS%\proev\WF50\ProevGerman.local

Sie erreichen die Windows Umgebungsvariablen unter: Systemsteuerung\System und

Sicherheit\System\Erweiterte Systemeinstellungen > Umgebungsvariablen.

e Die VERICUT-Schnittstelle wird in Pro/Engineer ab sofort unter Applikationen / VERICUT ...

angezeigt.

Die Installation der Schnittstelle ist nun abgeschlossen.
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6.7 hyperMILL-to-VERICUT

Diese Installationsanleitung bezieht sich auf hyperMILL 2014.2. Andere Versionen kdnnten

abweichen.
e Beenden Sie hyperMILL und VERICUT.
e Wahlen Sie aus dem Startmenti:
[Open Mind] > [hyperMILL] > [2014.2] > [Anwendungseinstellungen]

e Waihlen Sie [Neu] und fiillen Sie das sich 6ffnende Fenster wie folgt aus:

Fa R
1=+ Neue Anwendung — @
Schitissel ERICI -
Mame WERICUT
Programm C 'yCGTech \,\;'Eﬁli(.:ﬂﬁ:’rhavi-ndo-ws-ﬁqi\commandsil,ver.i.r_:L;f. b;lt
Argumente |
| 0K | | Abbrechen |
LS A

e Die VERICUT.bat Datei bestimmt mit welcher VERICUT-Version die Schnittstelle gestartet

wird. Verlassen Sie das Fenster mit [OK] und beenden Sie die Anwendungseinstellungen.

e In hyperMILL muss nun noch in den Postprozessor Einstellungen der jeweiligen Maschine der

Eintrag [Externe Simulation] > [Vericut] hinzugefiigt werden.

!B Maschineneigenschaften (=28

B Allgemein
MName c42u

[ | »

Typ
Aufnahme

Postprozessor kann gespeicherte Lésungen verwenden

Postprozessor D:\200_Schulungsdaten’.. \S8400_MT_TabAC_C_R2p.oma
Meodellmodus Modell aus MMF-Datei -
. 200 el " BATLL Ll laodall L
C _________________________________________________ - = TF
(E Externe Simulation 1| VERICUT v]
"ErNUipaTRte
Aletiviert

e Die Schnittstelle ist nun installiert.
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7. FAQ, haufige Fragen & Fehlermeldungen

7.1 Bedienoberfliache & Farbschema andern

VERICUT bringt verschiedene Bedienoberflachen mit sich. Fiur die Bedienoberflache , Windows” sind
in der Version 7.4 auch einzelne Farbschemen wahlbar. Diese Einstellungen sind unter folgenden

Punkten zu finden:

Bedienoberflache Windows Farbschema
!Ansschtllnfo Projekt K I 1 Analyss Opti ung Hilfe Almh‘-‘.lmn "
Layout » a— i
Orientierung... E%LC’ e it ﬁﬂ W %? Farbschema Hellgrau
Bl ‘ Bedienoberflache i
W Schneiden... l = Grau
; 7 ; Maustastenbelegung 5
Ansichten auswahlen/speichern...
 Koordinatensysteme... ) Logger Ansichts-Optionen EB Dunkelgrau
Symbolleiste konfigurieren.... 7 z
Auflbsung » [-F Blau
hscham »
= m Dunkelblau
Waustastenbelegung Motif
Logger Ansichts-Optionen Nimbus Agqua
| v windows
Windows Classic r}: Braun
v Textgrofe Voreinstellung
TextgroRe Mittel rF, Rot
TextgroRe GroR i
TextgroRe Exira Grof Oliv
Text groRer . X
Text kleiner [F Violett
Symbole Klein e
Vv | Symbole Mittel | [ Orange
Symbole GroR
Hinweis:

Die Standard-Einstellungen aus VERICUT 7.2 und friiher kénnen ab 7.3 folgendermafen gewdhlt
werden: Bedienoberflidche=Windows; Farbschema=Hellgrau

7.2 Downloadarchiv kann nicht entpackt werden /Kein giiltiges Archiv

Vermutlich gab es ein Problem beim Download, bitte wiederholen.

Eventuell unterstiitzt das verwendete Packprogramm keine Passwortgeschiitzten Archive.

Bitte mit einer aktuellen Version eines gangigen Packprogramms, wie WinZip, WinRAR oder 7Zip

testen.
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7.3 Es kann keine VERICUT Lizenz gefunden werden

Meldung:

Es kann keine VERICUT Lizenz gefunden werden. Der Lizenzserver ist eventuell nicht gestartet auf
{Lizenzserver} oder VERICUT kann keinen Kontakt aufnehmen mit {Lizenzserver}. Bitte schauen Sie in
die Installationshinweise fiir weitere Hilfe.

Lésungsvorschlag

e Mit dem Programm Lizenz Administrator (WImAdmin) aus dem Windows-Startmeni unter
Alle Programme > CGTech License Server > License Administration prifen ob der erwartete
Lizenzserver sichtbar ist.

e change_cgtenv.bat starten
Die Datei ist unter folgendem Pfade zu finden: VERICUT\

C:\Programme\VERICUT 7.4\windows64\commands
Prifen ob neben , LSHOST=" der richtige Lizenzserver angegeben ist.

e Priifen ob Windows den Lizenzserver erreichen kann. Dazu in die Windows
Kommandoanzeige wechseln und , ping xyz“ eingeben.

Xyz muss mit der unter LSHOST eingegebenen Adresse ersetzt werden.

e Inden Windows Umgebungsvariablen priifen ob LSHOST eingetragen ist. Falls nicht, diesen
Eintrag manuell hinzufiigen. Als Wert muss der Hostname des Lizenzservers angegeben

werden.

Falls dies nicht zum Erfolg flihrt sollte Punkt 4.3.1 noch einmal ausgefiihrt werden. Bitte darauf

achten, dass die Lizenz dauerhaft aktiviert wird.
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7.4 Lizenzserver wurde gefunden, aber CGTech Lizenzinformationen sind nicht vorhanden
Meldung:
Lizenzserver wurde gefunden, aber CGTech Lizenzinformationen sind nicht vorhanden. Eventuell

falsche Version des Lizenzservers oder der Lizenzdatei.
Bitte schauen Sie in die Installationshinweise fiir weitere Hilfe.

Lésungsvorschlag

e Prifen ob der Pfad zur Lizenzdatei richtig angegeben ist (auf dem Lizenzserver), dieser kann
Uber die Windows Umgebungsvariablen LSERVOPTS angegeben werden.
Der Wert der Variablen sieht ab VERICUT 7.4 immer gleich aus:

\—s "C:\ProgramData\CGTech\license\cgtech.If"

e Priifen ob die Datei vorhanden ist.

e Falls der Lizenzserver nicht auf den Arbeitsplatzcomputer lauft, priifen ob auf beiden
Rechnern (Server&Client) im Programm Lizenz Administrator (WImAdmin) bei Version im
Kasten Server information identische Werte stehen.

Die Version auf dem Server darf nicht alter sein.

¢  Mit WImAdmin priifen ob die Lizenzen VERIFICATION und VERICUT.WIN angezeigt werden.

Falls dies nicht zum Erfolg fiihrt sollte Punkt 4.3.1 noch einmal ausgefiihrt werden. Bitte darauf

achten, dass die Lizenz dauerhaft aktiviert wird.

Lésungsvorschlag 2

Priifen ob der Lizenzserver von ihrer Firewall blockiert wird.

Der Lizenzserver benétigt den Port 5093 auf Client- und Serverrechner.
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7.5 Lizenzserver wurde gefunden, aber es sind keine VERICUT Module vorhanden.

Meldung:

Lizenzserver wurde gefunden, aber es sind keine VERICUT Module vorhanden.

Lésungsvorschlag

e Diese Fehlermeldung tritt haufig auf wenn versucht wird VERICUT Standard mit einer
VERICUT LIMITED/SP-Lizenz auszufuhren.
Zum Betreiben von VERICUT wird eine Standard-Lizenz bendtigt.

e Falls im Startmendi kein VERICUT Limited/SP - Eintrag vorhanden ist, wurde dies bei der
Installation nicht ausgewahlt.
Ein neuer Eintrag kann durch kopieren der Datei ,Verkniipfung zu Limited VERICUT 64 7.4“

aus dem Installationsverzeichnis unter windows64\commands erzeugt werden.
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7.6 The given license code is invalid.

Meldung:

“

The given license code is invalid. Hence, it could not be added to the “..” license server.

Sentinel RAMS Development Kit B8.2.1.4008 License Addition~Deletion Utility
Copuyright <GC) 2008 SafeMet. Inc.

entinel RMS Development Kit: Ervor[?2]1: The given license code is invalid. Henc
» it could not be added to the " " license server.

Lésungsvorschlag 1

Fir VERICUT ab Version 7.3 wird mindestens die Version 8.5.3.35 der Lizenzserver-Software benétigt!

Die Version ist unter anderem tber WImAdmin einsehbar.

Bitte Punkt 4.2.1 folgen

Lésungsvorschlag 2

Die Lizenz-Codes diirfen keine Leerzeichen oder Zeilenumbriiche beinhalten. Diese werden teils
automatisch beim Speichern aus Outlook eingefiigt.

Als Alternative dazu kann der Email-Text per Copy & Paste in das Lizenz-Fenster eingefiigt werden.

Beispiele fiir Lizenz-Codes
Korrekt (ohne Zeilenumbriiche)

# CGTECH LICENSE 7.3 31-Dec-2013
*E Icwal3gSoKgt8JZsJTr0OE..geklrzt..88no0Bgt8JZ2TZXL3gSoXh33e
Fehlerhaft: (mit Zeilenumbriichen)

# CGTECH LICENSE 7.3 31-Dec-2013
*E IcwaKsJdgt8JZsJ

rOE..geklirzt..88no0
TrO0E3FrpvFGjMfmdv
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7.7 Cannot talk to license server
Meldung:

Cannot talk to licence server on host “CG6326”. Server not running?

Sentinel RMS Development Kit: Error(51: Cannot talk to the license server on hos

t "CG6326". Server not running??

Lésungsvorschlag 1

[Windows-Startmenii] >
[Programme/Dateien Durchsuchen]
> Suche nach ,,cmd“

Programme (2)
[RMT] auf ,cmd“ >

[Als Administrator ausfiihren] BN cmd.exe .
Offnen
B CmDust
_ "_; Als Administrator ausfihren
Microsoft Ou 7.7
-Zip

Geben Sie in der Kommandozeile BN Administrator C\Windows\System32\cmd.exe - setup_license_sery

folgende Befehle ein: Microsoft Windows [Version 6.1.76@11]
Copyright <c>» 200? Microsoft Corporation. Alle

cd Installationspfad License Server C:“MWindows“system32>cd C:“CGTech:\LicenseServer

Beispiel:

cd C:\CGTech\LicenseServer

In der nun dazu gekommenen C:sWindowsssystem32>cd C:\CGTech“LicenseServer

ndchsten Zeile tragen Sie bitte C:5CGTechs\LicenseServerrsetup_license_service.bhat
folgendes ein:

setup_license_service.bat

Bestatigen Sie zwei Mal mit einer
beliebigen Taste.

Folgen Sie nun Schritt 4.3.1 der
Installations-Anleitung.
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8. Weitere Hilfe

Kontaktdaten

Weitere Hilfe zu VERICUT erhalten Sie jederzeit Giber unseren Support:

CGTech GmbH
Neusser Landstr. 384
50769 Koln

Hotline: 0221-97996-0
Fax: 0221-97996-28

support.de@cgtech.com

Weblinks

Deutschsprachige Website: www.cgtech.de & www.maschinen-simulation.de

Englischsprachige Website: www.cgtech.com

Aktuelle Version dieser Anleitung: www.box.maschinen-simulation.de/install current.html

Hilfe-Forum

www.cgtech.com/forum
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